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Hej!
Efter en ganska kall och regnig sommar så kom hösten, inte kallare men
desto blötare. Det var många regnrekord som slogs hösten 2008.
Bladets utgivning har nog också slagit rekord, att inte komma ut i tid.
Det är många faktorer som är anledningen och det är ju inget som borde
stå ivägen för ABC-Bladet.  Men verkligheten ser ju helt annorlunda ut.

Men nu är bladet klart och vi i redaktionen hoppas att det kommer att
vara bra läsning för er medlemmar. Trots att det inte blev så många sidor
denna gång så är innehållet desto mer intressant.
Att antalet sidor stannade på 16 beror helt enkelt på att vi inte fått in
tillräckligt med material så att vi kan fylla en 24 sidors tidning.
Vi får hoppas att det var en engångsföreteelse och att det kanske var den
dåliga och regniga sommaren som var orsaken. Eller den helt eländiga
hösten. Däremot så är innehållet av bästa kvalité. Med mycket bra artiklar
av mycket duktiga medlemmar.

Ferdinand Mican,s helt underbara artikel om läromedelsprogram på nätet
var nog min favorit. Ni som vill lära er bildbehandlingsprogrammens
hemligheter hittar många bra länkar om det ämnet i hans artikel.
Gabriel Kihlman berättar om hur du kan utnyttja att klubben använder
DNSSEC.
Bo Saltorp synar Windows XP och Vista.
Johan Persson redogör om Effektförbrukning i moderna datorer.
Johan Kullberg förklarar hur man som användare av Windowsservern
hanterar sina filer på ett sätt så att lösenord och annat inte överförs i
klartext över linan, som sker med t ex Telnet, rlogin och FTP.

För att vi i fortsättningen ska få nöjet att ha så mycket intressant och
värdefullt innehåll i bladet så måste ni medlemmar hjälpa till att dela med
er av era kunskaper.

Vi tar tacksamt emot allt bidrag som går att publicera i bladet. Det går lika
bra med en liten notis som en hel avhandling, en historia eller varför inte
ett korsord. Små som stora bidrag spelar ingen roll. Bara det blir något
som dimper ner i redaktionens brevlåda.

Jag önskar er en angenäm läsning och hoppas att ni nappar på mitt
upprop om att skicka in bidrag till ABC-Bladet

Elisabeth, chefsredaktör
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Jag hoppas att jag åtminstone
kan hjälpa ABC-Klubbens med-
lemmar lite med det första pro-
blemet när det gäller kunskap
inom Photoshop Elements och
Dreamweaver.

Det optimala är naturligtvis när
man kan gå en riktig utbildning.
Oavsett om det är en kvällskurs
eller en högskoleutbildning så är
det att föredra framför att sitta en-
sam bakom en dator.

Kontakten med läraren och fram-
förallt med klasskompisar gör en
utbildning IRL överlägsen.
Men om man nu inte har de möj-
ligheter. Om man är för snål eller
av någon annan anledning är
tvungen att sitta hemma i kamma-
ren och försöker lära sig saker på
egen hand, hur gör man då? Då är
det naturligtvis Internet som gäl-
ler.

Vid mina marknadsundersök-
ningar (läs google) så fick jag veta
mycket om ”e-learning” och ut-
bildning över Internet på länken
http://www.learntech.se/resurser/
ekurser/2_vad_ar_elarande/
player.html
Rekommenderas om ni vill läsa
ingående om e-learning.

Jag är intresserad av foto sedan
barnsben och har en bra grundut-
bildning i den grafiska branschen.
När jag nu öppnade eget så kände
jag att jag behövde hämta in lite nya
kunskaper för att aktualisera min ut-
bildning.
Från min tid som anställd hade jag
med mig kontakten med Adobe.
I programpaketet  CS3 ingår hand-
böcker och utbildningsmaterial.
Adobe har dessutom verkligen
mycket intressanta videosnuttar på

hemsidan, http://www.adobe.com/
designcenter/video_workshop/

Tyvärr har de endast ett mycket
begränsat urval av ämnen på
Internet. Visserligen till alla(?)
Adobe-program men man känner
ändå inte att man lär sig något vik-
tigt. Framför allt får man ingen
helhetsbild utan endast fragment.
Är man inte nöjd med Adobes
handböcker så har Pogue Press
O’Reilly  gett ut en serie som man

Med Internet som
lärare

Nog finns det mycket kunskap på Internet. Första problemet är att
hitta kunskapen men när man väl har hittat den så kommer nästa
problem - att få tid att tillgodogöra sig allt.

 Bild 1: Bild 1: Bild 1: Bild 1: Bild 1: förhandstitta på CartoonSmarts populära kurser
 http://www.cartoonsmart.com/demo_index.html
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kallar ”The missing manuals”.
http://safari.oreilly.com/video?
cid=2008_videopromo_homepage
säljer samma kurser som
www.lynda.com.
För 25$/månad kan man använda
deras bibliotek bestående av
30.768 videos.

De har även 284 utbildnings CDn
som kostar mellan 50 och 100$ för
ett stort antal program.
Några av lektionerna kan man kolla
in gratis på deras hemsida. Gemen-
samt för dem som jag lyssnade på
var att läraren pratar på ackord.
Men det är kanske standard-USA-
hastighet.

Sammanlagt flera timmars för-
handstips på CartoonSmarts popu-
lära kurser kan du följa på
http://www.cartoonsmart.com/
demo_index.html

Visserligen får du betala om du vill
ha hela kursen, men i demo-
versionen får man ändå en bra in-
blick i programmeringsteknik för
Flash , Dreamweaver och Blender.
Det sistnämnda är ett fritt program
för bl.a. rendering, animationer och
spel. En intressant iakttagelse är att
även DeStoraGrabbarna (kör med
”TrialAndError”-tekniken.

En sak till – se till att du är utvilad
annars är det lätt att somna under
lektionen. Det kan antingen bero på
att lektionen är för elementär eller
att den är (för) avancerad.
 Se bild 1.

Bland engelskspråkiga gratis-
utbildningar kan jag rekommen-
dera Sony’s e-kurser. Jag upptäckte
dem av en tillfällighet när jag hade
köpt Sonys filmredigerings-

program ”Vegas Movie 6.0”.
Först tog jag kursen för
Webbdesign, fortsatte sedan med
Photoshop och går nu kursen för
Vegas. Alla kurser består av kurs-

Engelskspråkiga gratisutbildningarEngelskspråkiga gratisutbildningarEngelskspråkiga gratisutbildningarEngelskspråkiga gratisutbildningarEngelskspråkiga gratisutbildningar

Då vi är regält försenade så

måste redaktionen få in era

bidrag senast den sista

november. Vi är alltså under

tidspress men med er hjälp

så ska det nog gå.

Så snälla, skicka in bidrag till

bladet.  Adressen är:

 red@abc.se

Manusstopp till ABCManusstopp till ABCManusstopp till ABCManusstopp till ABCManusstopp till ABC-Bladet-Bladet-Bladet-Bladet-Bladet

Bild 2:Bild 2:Bild 2:Bild 2:Bild 2: På SONYS hemsida finns många olika kurser.
http:/ backstage101.learningcenter.sony.us/

Bild 3.Bild 3.Bild 3.Bild 3.Bild 3. Digitalfoto
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brev, arbetsuppgifter och ett avslu-
tande Quiz med frågor. Men det
finns även ett ”Message Board” för
kontakt med läraren och klass-
kompisar.
Lagom långa kurser i de mest
skilda ämnen. Naturligtvis är de
elementära. På den korta tiden kan
man inte gå på djupet men man får
tips på nyttiga länkar.
 När du är klar kan du själv skriva
ut ett intyg att du har gått kursen.
Det bästa är att de är gratis – man
behöver inte ens vara en Sony
kund – det räcker att man tål lite
produktreklam.
Det finns många kurser inom
Sonys verksamhetsområde som är
foto, camcorder, tv, mp3, musik,
spel och datorer.
Kolla själv på http://backstage101.
learningcenter.sony.us/
Se bild 2 föregående sida

Instruktionsfilmer på Engelska
Engelska är också språket i
instruktionsfilmerna som finns i
tidningen Digitalfotos filarkiv
http://www.firstfoto.se/default.
asp?sida=1038

Egentligen inte så konstigt – mate-
rialet i tidningen är ju översatt från
en engelsk fototidning. Och att
översätta även instruktionsfilmerna
kostar man inte på sig.

Bra att man har tidningen med alla
steg som bilden går igenom, alla
inställningar finns beskrivna i tid-
ningen.
Sedan kan man följa arbetsgången
på datorn med tidningen bredvid.
Se bild 3, föregående sida

Av alla svenska sajter som sysslar
med utbildning i Photoshop så
gillar jag bäst
www.moderskeppet.se. Lärarna är
avslappnade, sakliga och hittaren
bra ton.
 Se bild 4.

Förutom korta lektioner som är gra-
tis så säljer man även DVD-kurser.
En del kunskap kan man även in-
hämta hos www.webdesignskolan.se.

Det finns en del tips på hemsidan
inom webbdesign, photoshop,
dreamweaver, flash och illustrator.
För att få tillgång till allt så måste
man bli medlem för 299 kr per år.
Sajten har även ett forum där man
kan ställa och besvara frågor.

Vill man kosta på sig ett antal
tusenlappar så finns t.ex. Klick
Data med interaktiva utbildnings-
produkter med ett brett utbud av
svenska e-kurser inom it och affärs-
utveckling.
 Se mera på www.klickdata.se.

Kurser levereras antingen på
CD-ROM eller via adressen
www.klickportalen.se/klickdata
med ett lösenord och spelas upp i
programvaran W3 med Flash som

plugin, under en tidsperiod av 12
månader. Tillhörande test i Exa-
mina E3 ingår.

Tyvärr är kurserna rätt så dyra så
förmodligen är det mest företag
som finns bland kunderna.

Ferdinand Mican <912>

Redaktionen efterlyser

material till kommande

ABC-blad.

Vi är glada för allt som ni

medlemmar kan bidra med.

Utan er blir det ingen

medlemstidning så vi måste

alla hjälpas åt att förse

redaktionen med material.

Ni skickar ert bidrag till

red@abc.se

EfterlysningEfterlysningEfterlysningEfterlysningEfterlysning

Bild 4.Bild 4.Bild 4.Bild 4.Bild 4. Moderskeppets Utbildning i Photoshop är i mitt
tycke bäst. www.moderkseppet .se
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Säker
namnuppslagning

en artikel om hur du kan utnyttja att klubben använder DNSSEC.

Klubben har sedan en tid
DNSSEC för abc.se-domänen.
Eftersom .SE-zonen dessutom är
signerad kan man som
användare vara säker på att när
man skriver in www.abc.se i sin
webläsare så kommer den rätta
IP-addressen att användas.
Ingen kan därmed spoofa
klubbens addresser. Fast det
gäller enbart om din närmaste
DNS-server stödjer DNSSEC.
Gör den inte det kan ni följa
anvisningarna i den här artikeln
för att fixa en egen.

Att klubben har en signerad zon
innebär rent tekniskt att slut-
användaren eller andra DNS-
servrar kan verifiera att svaren de
får på sina zon-frågor inte är
manipulerade. Jag vet att Telia till
exempel gör det för de gånger jag
glömde att signera om abc.se så
försvann zonen abc.se för alla Telia
DNS-användare. Oops :-)

Om din leverantörs DNS-servrar
verifierar zoner åt dig kan du se
med verktyget 'dig'. Om du kör
någon unix-variant har du det
antagligen installerat och kan
öppna upp en terminal och sen
knappa in:

$ dig +dnssec +multiline -t soa
orm.abc.se

Överst i svaret efter du tryckt enter
finns det en sektion som ser ut såhär
hos mig:

;; flags: qr rd ra ad; QUERY: 1,
ANSWER: 0, AUTHORITY: 4,
ADDITIONAL: 1

ad-flaggan innebär att svaret är
verifierat med DNSSEC i den
DNS-server jag frågar. AD står för
Authentic Data.
Så ser det antagligen inte ut hos dig,

förutom om du har Telia, men jag
ska nu beskriva hur du kan göra för
att det ska bli så. Det finns flera
produkter men jag valde unbound,
en DNS-server utvecklad av NLnet
Labs, som jag sätter upp på min
egen maskin.

Först måste du ladda ner den från
http://unbound.net, packa upp och
köra ./configure && make &&
make install.
Se bild 1 och 2

   Bild 1.   Bild 1.   Bild 1.   Bild 1.   Bild 1.  Så här ser sidan ut där du laddar ner DNS-servern ifrån
   http://unbound.net
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Sen är det bara att editera /usr/local/
etc/unbound unbound.conf enligt
dina önskemål men framförallt är
det viktigt att sätta följande:
trusted-keys-file: "/usr/local/etc/
unbound/keys"

Keys-filen finns inte utan den ska
du skapa själv och lägga in .SE-
zonens nycklar. Eftersom .SE
signerar ABC.SE så är det allt du
behöver göra.
I rutan nedan klipper du och klistrar
från online-bilagen av bladet.

Om du sätter upp detta måste du
även se till att prenumerera på
NIC.SEs nyhetsbrev så att du får
redan på när du måste rotera nyckel
i din unbound.conf-konfiguration.

Lycka till och ställ gärna frågor i
ABCKOM om det är något du
undrar över.

Gabriel Kihlman  <10723>

Klipp och klistra nedan från online-bilagan av Bladet

trusted-keys {        // key id = 6166, valid for 2007, must be  replaced latest        2008-12        "se." 257 3
5"AwEAAb6x RZHEf+Py F5dxEvz0BHEHbziu6iZaiNW/
yjSaZcmrmZiRMF8FPppD+XuKSau0rgu4eBwYdpkEoMVR4FhI8frkuPHIue2LP1ETo+2hCrdr60K1538yLvzbO
hMxXt6knjPN+OlalMmCknadaofKga5FLKOPQs2C3nw6AH4WUNGrchmDMVBwRwfZdQXYZTXesqULmGMK
7 m w j Q G O x e r R D Q W r F v 8 N h N n V V 3 1 P i h a Y B d Q 1 T J j v f G S / F Y Z J w v /
BddiELiLeUnNWu3AOsRAshgOcDBOAPUvKJNEq6RHELFmvXOOe2d8H2yzv02EMQik6GwUm16DrSdmX
+SWfelQs+9ELFN6k=";
        // key id = 49678, valid for 2008
        "se." 257 3 5
        "AwEAAdKc1sGsbv5jjeJ141IxNSTdR+nbtFn+JKQpvFZETaY5iMutoyWHa+jCp0TBBAzB2trGHz
di7E55FFzbeG0r+G6SJbJ4DXYSpiiELPiu0i+jPp3C3kNwiqpPpQHWaYDS9MTQMu/QZHR/
sFPbUnsK30fuQbKKkKgnADms0aXalYUuCgDyVMjdxRLz5yzLoaSO9m5ii5cI0dQNCjexvj9M4ec6w
oi6+N8v1pOmQAQ9at5Fd8A6tAxZI8tdlEUnXYgNwb8eVZEWsgXtBhoyAru7Tzw+F6ToYq6hmKhfsT+fIhFXsYso
7L4nYUqTnM4VOZgNhcTv+qVQkHfOOeJKUkNB8Qc=";};

Sen till sist ändra i /etc/resolv.conf så att det står "nameserver 127.0.0.1" och inget annat där (förutom
kanske nameserver ::1).
I  början är det ganska bra att ha satt logfile:
"/usr/local/etc/unbound/log" i unbound.conf så att du lätt kan se vad som händer.

Nyttiga länkar för vidareläsningNyttiga länkar för vidareläsningNyttiga länkar för vidareläsningNyttiga länkar för vidareläsningNyttiga länkar för vidareläsning
[1] NIC.SEs mailinglista och
annat:
   http://www.iis.se/products/
sednssec2/dnssectech

[2] Väldigt bra guide över
DNSSEC:
   http://www.nlnetlabs.nl/
dnssec_howto/
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En gammal hunds syn
på Windows Vista

När jag läste Sven WNär jag läste Sven WNär jag läste Sven WNär jag läste Sven WNär jag läste Sven Wickbergs artikel ”Gamla Hundarickbergs artikel ”Gamla Hundarickbergs artikel ”Gamla Hundarickbergs artikel ”Gamla Hundarickbergs artikel ”Gamla Hundar” i nummer” i nummer” i nummer” i nummer” i nummer
2008:1 av ABC2008:1 av ABC2008:1 av ABC2008:1 av ABC2008:1 av ABC-bladet, fick jag idén att skriva om skillnader mellan-bladet, fick jag idén att skriva om skillnader mellan-bladet, fick jag idén att skriva om skillnader mellan-bladet, fick jag idén att skriva om skillnader mellan-bladet, fick jag idén att skriva om skillnader mellan
WWWWWindows XP och Vindows XP och Vindows XP och Vindows XP och Vindows XP och Vista.ista.ista.ista.ista. Svens artikel handlade huvudsakligen omSvens artikel handlade huvudsakligen omSvens artikel handlade huvudsakligen omSvens artikel handlade huvudsakligen omSvens artikel handlade huvudsakligen om
skillnader mellan tidigare versioner av Microsoft Office och Microsoftskillnader mellan tidigare versioner av Microsoft Office och Microsoftskillnader mellan tidigare versioner av Microsoft Office och Microsoftskillnader mellan tidigare versioner av Microsoft Office och Microsoftskillnader mellan tidigare versioner av Microsoft Office och Microsoft
Office 2007, men även VOffice 2007, men även VOffice 2007, men även VOffice 2007, men även VOffice 2007, men även Vista fick en känga.ista fick en känga.ista fick en känga.ista fick en känga.ista fick en känga.

Nu är också jag en gammal hund,
som tycker det var bättre förr. Eller
nästan bättre förr.
Är du en gammal hund, som kan
XP, men som fått Vista på halsen,
t.ex. förinstallerad på en ny Laptop,
har du förhoppningsvis glädje av
denna artikel.

Eftersom jag alltid kör engelska
versioner av program, använder jag de
namn, som finns i mina versioner av
XP och Vista. Jag har dock inom
parentes angett motsvarande svenska
beteckning, när inte översättningen är
självklar.

Inställningar i Start Menu,
Control Panel och Explorer

1.1 Start (Menu)
Vista´s sätt att visa installerade
program i Start Menu är, som jag ser
det, inte överskådlig. Man får inte
utåtsvängande menyer som i XP,
utan man måste scrolla eller klicka
för att se nästa menysteg. Byt till
Classic Start Menu enligt följande:
Högerklicka på Start, välj Properties
(Egenskaper), välj fliken Start Menu
och klicka där i ”radioknappen” för
Classic Start Menu.

1.2 Control Panel
Här finns många ändringar, men de
viktigast är:

1. Ikonen Add/Remove
Programs heter i Vista
Programs and Features
(Program och funktioner)

2. Ikonen Default Programs
(Standardprogram) har
tillkommit. Här görs nu
sådant som anges nedan
under avsnitt 1.3 Explorer
punkt 6.

3. Ikonen Display har ersatts
av Personalization
(Anpassning), som sedan, i
stället för flikar för Display
Settings, Screen Saver o.s.v.
har ikoner för dessa plus
inställningar för mus och
ljud.

1.3 Explorer (Utforska-
ren)
Här har de största ändringarna gjorts,
vilka innebär att man i Vista inte
förmodas söka upp och ner i filträd,
som man gjorde i XP. Det är inte helt
enkelt att förklara vad detta innebär,
men om du vill fortsätta som i XP, är
nedanstående bra att kunna.

1. Få Explorer (Utforskaren)
att starta, så att alla enheter

(hårddiskar, partitioner
o.s.v.) visas.

Windowstangent +  bokstaven e-
tangent fungerar  på samma
sätt som i XP.

2. Tillfälligt få menyn File,
Edit o.s.v. överst i Explorer.

Välj Organize (Ordna) > Layout
> Menu Bar.

Om meny endast önskas
tillfälligt, när Menu Bar ej
valts, tryck tangenten ALT.

3. Permanent få menyn File,
Edit o.s.v. i Explorer.

Välj Organize (Ordna) > Folder
and Search Options >
Klicka i “radioknappen” för
Use Windows classic
folders.

4. Få filträd i vänstra delen av
Explorer

Välj Organize (Ordna) > Layout
> Navigation Pane

5. Ta bort indexering av
mappar

Eftersom Vista´s huvudprincip,
när man letar efter filer, är
att använda sökruta och där
ange filens innehåll, så
måste hela hårddisken
indexeras. Detta kan ta
avsevärd tid och kapacitet.
En gammal hund letar efter
filnamn, vilket görs i filträd
eller genom sökning på
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filnamn, vilket inte kräver
indexering.

För att få bort indexeringen,
öppna Control Panel och
klicka på Indexing Options.

Här kan man ta bort eller lägga
till vilka mappar, som skall
indexeras. .

6. Ange vilket program, som
skall öppna fil med viss file
extension (filändelse).

Detta fanns i XP under Tools >
Folder Options > fliken File
Types, men är nu flyttat till
Control Panel > Default
Program (Standardprogram)
> Associate a file type or
protocol with a program.

1.4 Task Manager
(Aktivitetshanteraren)
Här har i Vista skett en del
förbättringar.
Under fliken Processes har tillkommit
kolumnen Description, som anger till
vilket program eller funktion, som
processen hör. Vidare kan man
högerklicka på en process, välja Open
File location och få reda på var
programmet/funktionen ligger på
hårddisken.

2.Nätverk
Det enklaste sättet att i Vista göra de
vanligaste nätverksinställningarna är
att välja Control Panel > Network and
Sharing Center, som ser ut så här.
(se bild till  höger)
Om Vista under installationen har
hittat Ethernet-adaptern och man är
ansluten till en router med DHCP, så
blir nätverket automatiskt etablerat
med namnet Network 1. Om man inte
är nöjd med detta namn och vald ikon,
kan man ändra genom att klicka på
texten Customize (Anpassa). Jag har
som synes ändrat nätverksnamnet till
Network Granliden.

När Vista installerats är nätverket
inställt enligt följande:
Network discovery
(Nätverksidentifiering): On.
Innebär att din dator syns och att andra
datorer på ditt nätverk ser din.
Password protected sharing: On.

Detta innebär att användarna på andra
datorer på nätet, måste har lösenord,
för att kunna titta på dina utdelade
filer.

För att övriga datorer på nätet skall
kunna se utdelade mappar, måste
också File sharing ställas i läge On och
givetvis de mappar, som skall kunna
läsas, göras delade (shared). Det
sistnämna görs på samma sätt som i
XP.

I Network and Sharing Center kan
man också se vilken IP-adress man har
på det lokala nätet genom att på raden
”Connection      Local Area
Connection” (Anslutning   Anslutning
till lokalt nätverk) klicka på texten
View status (Visa status). Då öppnas
ett fönster med bl.a. knappen
Details…(Information…). , som efter
ett klick visar IP-adressen.
I XP ser man ju IP-adressen efter
dubbelklick på ikonen Network
Connections i Control Panel´s, när
man i fönstret, som öppnas, markerar
Local Area Connection.

3. Diverse tips

1. Utnyttja Vista’s sleep mode.
(Viloläge)

Detta fungerar som en
kombination av  XP:s Stand
By och Hibernate. Ingen av

dessa var särskilt bra,
eftersom de var så
långsamma. Vista´s Sleep
mode  avslutar och startar on
mycket snabbt samt stänger
av allt utom CPU och RAM-
minne.

Välj Start > Högerpil > Sleep. För
att starta igen, tryck snabbt på
datorns Power on-knapp.

2. Logga in utan att behöva ange
lösenord.

Välj  Start > Run…., skriv
”netplwiz” (utan
citationstecken) och klicka
OK. Avbocka sedan den
kryssruta, som heter  “Users
must enter a user name…..”
och klicka sedan på Apply. I
det fönster, som då öppnas,
skriv in gällande lösenord två
gånger och klicka sedan på
OK.

3. Köra gamla program i
compatibility mode

Högerklicka på programmets  .exe
fil och välj Properties
(Egenskaper). Klicka på
fliken  Compatibility tab.

Kryssa I kryssrutan för “Run this
program in compatibility
mode” och välj  OS (Win95,
Windows 2000 etc.)

4. Task manager startas med
CTRL+SHIFT+ESC. Det
fungerar också (som i XP)

Här syns de vanligaste nätverksinställningarna i Vista
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med CTRL+ALT+DELETE,
men då måste man i ett nytt
fönster välja Start Task
Manager, för att komma dit.

5. Aktivera Administrator-
kontot (=visa detta på
inloggningsskärmen)

I XP kunde man komma åt
Administrator genom att
starta i Safe Mode (F8), men
det fungerar inte Vista. Då
finns två metoder.

Metod a:
Skriv i Start > Run… : net user

administrator /active:yes
(OBS! 3 mellanslag) och
klicka sedan OK.

Deaktivera Administrator-kontot
(=visa inte detta på
inloggningsskärmen):

Skriv i Start > Run… : net user
administrator /active:no
(OBS! 3 mellanslag) och
klicka sedan OK.

Metod b:
Välj Start > Control Panel >

Administrative Tools >
Computer Management.
Välj sedan Local Users and
Groups > Users.

Dubbelklicka på Administrator
och avbocka rutan vid
Account is disabled. Klicka
sedan på Apply.

6. Placera Run… på Start-
menyn

Högerklicka på Start, välj
Properties och klicka
Customize… och markera
rutan vid Display Run

4. Standardmapp-
benämningar och mapp-
placeringarna i Vista
De flesta standardmappar (My
documents etc…) har nya namn i Vista
enligt nedan.
Något, som också är förvirrande, är
att det också finns mappar, med
samma namn som i XP (t.ex.
Documents and Settings), men dessa
kan inte öppnas. Vidare finns t.ex.
under  Users\user\Documents en
mapp, som heter My Documents, men
den kan man inte heller öppna.
Glöm därför allt, som gällde för XP
och lär in följande!
I tabellen nedan är på samma rad
angivet mappar med motsvarande
innehåll, t.ex. motsvaras undermappen
\Application Data i XP av
undermappen \AppData\Roaming i
Vista

5. Snipping Tool
Detta är ett verktyg, vars motsvarighet
inte finns i XP. Det kan kopiera en
godtycklig del av skärmen till
Clipboard.
Man kan alternativt direkt spara den
valda skärmytan till en fil (jpg, png,
gif eller html).
Välj Start > Programs > Accessories
> Snipping Tool.

6. Defragmenteraren
Denna är tänkt att endast arbeta i
bakgrunden. Man kan därför inte som
i XP, se hur defragmenterad disken är
eller, när defragmenteringen startat, se
hur många procent, som återstår.

I ursprungsversionen av Vista, d.v.s.
före SP1, kan endast den partition,
som innehåller Vista defragmenteras.
I SP1 kan visserligen alla partitioner
defragmenteras, men det tar en sanslös
lång tid innan man får möjlighet att
välja den partition man vill
defragmentera. Man kan inte heller se
hur långt en pågående
defragmentering kommit.
Så rådet blir: Skaffa en 3:e parts
defragmenterare, t.ex. Auslogics, som
finns att gratis hämta på
www.auslogics.com/disk-frag.
I Auslogics  måste en inställning göras
efter installation, om man vill kunna
defragmentera USB-diskar. Gå till
Settings > Program settings, välj fliken
Defragmentation och kryssa i rutan för
Display removable drives

7.Sammanfattning
Min högst personliga uppfattning är,
att man inte får särskilt mycket nytt
genom gå från XP till Vista. Men om
man vill hänga med i utvecklingen
(och inte tror att Linux, skall segra!)
bör man nog lära sig Vista. Förslagsvis
omvandlar man sin XP-dator till en
dualboot dator, genom att inifrån XP,
installera Vista. Där fås automatiskt en
boot manager, som medger uppstart
antingen till XP eller Vista.
Det finns dock en nackdel med en
sådan dator. Varje gång man bootar till
XP, så förstörs alla de Restore points
(Återstartpunkter) man hade i Vista!
Ja, det är sant och detta är enligt
Microsoft ingen bug!

Bo Saltorp <7585>

XP

I mappen Documents and Settings\user\
finns följande undermappar

Application Data
Cookies
Local Settings
My Documents
NetHood
PrintHood
SendTo
Start Menu
Templates

Vista

I mappen Users\user\
finns följande undermappar

\AppData\Roaming
\AppData\Roaming\Microsoft\Windows\Cookies
\AppData\Local
\Documents
\AppData\Roaming\Microsoft\Windows\Network Shortcuts
\AppData\Roaming\Microsoft\Windows\Printer Shortcuts
\AppData\Roaming\Microsoft\Windows\SendTo
\AppData\Roaming\Microsoft\Windows\Start Menu
\AppData\Roaming\Microsoft\Windows\Templates
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Nyligen tog jag fram mina två se-
naste datorer, en desktop (statio-
när dator) och en laptop (bärbar
dator) och mätte deras respektive
förbrukning.

Först och främst var jag tvungen att
komma underfund med hur mycket
jag använder mina datorer, dvs hur
många timmar per vecka de an-
vänds respektive är försatta i vilo-
läge (standby).
Min användning är en blandning av
passiv användning (skärmsläckaren
är igång) samt aktiv användning
("normal" användning samt lite
spelande).

Jag kom fram till att använd-
ningstiden per vecka blev ungefär
(5*(2,5+4,5) + 2*14) = 63 timmar.
Som synes är datorn igång betydligt
mer under helgerna.

Under vardagar är den normalt
igång lite på morgonen samt på
kvällen. Tiden för viloläge blir
resterande tid som datorn inte är
fysiskt avstängd, dvs (5*7,5 + 2*10)
= 57,5 timmar.

Laptop
När det gäller min laptop så mätte
jag upp dess förbrukning till
25..30W vid normal användning,
exklusive de 11W som högtalaren
drar.
När skärmsläckaren går igång drar

datorn 30..40W istället, med toppar
på 60..75W när det gäller 3D-
spelande. För att försätta datorn i
viloläge så viker jag bara ned
datorlocket, praktiskt! Mätningar
visar dessutom att den bara drar 1W
i viloläget, utmärkt!

I ABC-bladet 2/2005 skrev jag en liten artikel om
"Effektförbrukningen hos våra datorer", något som i
dessa tider med allt dyrare el bara blir intressantare.

Effektförbrukning

En subwoofer är en högtalare som bara
spelar låga frekvenser. Om man har 2.1
eller 5.1 eller 7.1 högtalare betyder
1:an att det finns en subwoofer.
Subwoofern brukar återge ljud i
frekvenser mellan 20 och 120 Hz. De
kan vara svåra för örat att uppfatta,
istället kan man ”känna” ljudet i kroppen
och andra föremål i närheten i form av
vibrationer.
En subwoofer kan vara aktiv eller passiv.
Den aktiva drivs av en egen förstärkare
och behöver inte kraft från annan
förstärkare.

Källa: http://sv.wikipedia.org/wiki/Subwoofer

8<

i moderna datoreri moderna datoreri moderna datoreri moderna datoreri moderna datorer
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Dessvärre saboterar högtalaren det
hela genom att envist fortsätta dra
sina 11W, oavsett om datorn är i
viloläge eller inte.
Faktum är att även när jag stänger
av högtalaren (med volymknappen
på småhögtalarna) så drar den
fortfarande 9W och det finns ingen
huvudavstängningsknapp.
Kan det vara pga subwoofern? I
vilket fall som helst är detta inte bra.

Effekten som går åt vid användning
beräknar jag till ca 45W
(dator(34W) + högtalare (11W))
samt dito i viloläge till 12W
(dator(1W) + högtalare(11W)).

Här finns det faktiskt en klar
möjlighet att påverka energi-
förbrukningen genom att istället
välja en mindre högtalare som
saknar subwoofer.

En subwoofer ger mycket bra
ljudeffekter vid musik och datorspel
men spelar inte så stor roll om man
bara lyssnar på musik eller radio vid
relativt låga ljudnivåer.
Jag har en liten högtalare som
saknar subwoofer och den drivs via
USB från datorn. Denna lilla
högtalare verkar dra upp till 2W när
datorn (och högtalaren) är igång.
Effekten blir då 36W (dator(34W)
+ högtalare(2W)) vid användning
respektive 1W i viloläge.

Summan av kardemumman är att
datorn vid användning, per vecka,
drar ca 63 timmar * 45W =
2,8KWh, samt ytterligare 57,5
timmar * 12W = 690Wh i viloläge
(varav högtalaren tar det mesta).
Totalt blir detta ca 3,5KWh per
vecka i ren energiåtgång för den lilla
laptopen.
Räknar man ut detta på årsbasis så
får man fram 3,5*52 = ca 182KWh.
Med den mindre högtalaren blir det
istället 2,3KWh per vecka och ca
120KWh per år.

Desktop
Om vi nu tar och tittar på
desktopen så är situationen lite
annorlunda. Datorn drar vid
användning runt 44..64W, skärmen
(en 19" TFT-skärm) drar 30W samt
högtalaren som förstås drar sina
11W. Summan av detta blir runt
85W.

Går skärmsläckaren igång ligger vi
i intervallet 85..120W. Vid 3D-
spelande går det åt upp till 163W.
Man kan ju fråga sig varför man
har ett nätaggregat på flera hundra
watt när man aldrig använder mer
än kanske 200W?

Jag märkte f.ö. en liten underlighet
vad gäller TFT-skärmen när jag
mätte. Det visade sig att när den
var fysiskt avstängd så försvann
30W, men när jag "bara" stängde
av den med knappen på framsidan
(som man normalt gör då det är
jobbigt att komma åt att stänga av
den på riktigt) så försvann enbart
18W.
Det innebär att när jag trodde att
jag stängde av skärmen med
knappen på framsidan så försatte
jag den i verkligheten bara i
viloläge, med resultatet att den
fortsatte dra 12W. Illa!

När det gäller desktopen så brukar
jag aldrig stänga av den fysiskt
utan stänger helt enkelt bara av
skärmen med den där knappen på
framsidan (som vi nu vet bara
försätter skärmen i viloläge).

Effekten som går åt vid
användning beräknar jag här till ca
100W (dator(59W) + skärm(30W)
+ högtalare(11W)).
Dito i viloläge blir 67W (dator
(44W, stängs inte av) + skärm
(12W) + högtalare(11W)).

Summan här blir 63 timmar *
100W = 6,3KWh vid användning,

samt ytterligare 57,5 timmar * 67W
= 3,8KWh i viloläget. Totalt blir
detta 10,1KWh per vecka i
energiåtgång för desktopen.
På årsbasis blir detta 10,1*52 = ca
525KWh.

Summering
En laptop har förstås sina
begränsningar och jag vet att vissa
väljer att ha en extraskärm samt
tangentbord m.m. till denna. Då blir
förstås beräkningarna lite
annorlunda. Notera att även om min
laptop fysiskt sett är mindre än
desktopen så är den
prestandamässigt minst lika bra på
nästan alla plan, med en topp för
3D-prestanda där den totalt
utklassar desktopen (3DMark06,
4290 poäng vs 2233 poäng), samt
en lägstanotering för
minneshastigheten (667MHz vs
800MHz). Det är därför ingen
tvekan om att man kan jämföra dem
sida vid sida. Det är heller ingen
tvekan om att laptopen är
energisnål, även om jag så stänger
av desktopen under natten så
kommer jag aldrig ens i närheten
av den lilla mängd energi som
laptopen använder.

Johan Persson <2397>

Gör som Jonas Andersson <10711>

och starta en blogg  på

ABC-klubben.

Så här tycker han om det....

------------8<---------------

Vi har haft diskussioner här i

ABC-klubben. Bra diskussioner om

bloggning, web 2.0 och allting.

Frågan om vilka bloggverktyg man kan

ha på klubbens server kom upp.

Eftersom jag var rätt säker på att det

skulle gå att installera Wordpress här

bestämmde jag mig för att prova.

 Här ser ni resultatet.

Det tog tio minuter ungefär.

http://www.abc.se/~m10711

/min-nya-abc-blo/

 Starta en BloggStarta en BloggStarta en BloggStarta en BloggStarta en Blogg
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Med CopSSH kan du som
användare hantera dina filer på
Windows-servern på ett sätt så
inte lösenord och annat inte över-
förs i klartext överlinan, som
sker med t ex Telnet, rlogin och
FTP.

För att du skall kunna använda
CopSSH måste du skicka ett email
till windows@abc.se och be oss att
lägga upp dig i CopSSH - vi har
inte gjort detta automatiskt för alla
användare.

CopSSH är en paketering av por-
tabel OpenSSH, cygwin och en del
verktyg som Windows-administra-
törerna behöver för att sätta upp
och hantera det hela. Cygwin är en
Linux-liknande miljö för Windows.

När du SSH-loggar in till Windows-
servern (windows.abc.se) med t ex
PuTTY  (sehttp:/www.chiark.
greenend.org.uk/~sgtatham/putty/ )
så får du ett bash-kommandoskal
där du slår kommandon som i vil-
ket bash-skal som helst.

Det här är faktiskt det enda sättet
för ABC-medlemmar att verkligen
kunna hantera sina filkataloger på
Windows-servern (utom möjligen
det man kan göra med ren FTP och
FrontPage Server Extension), efter-
som vi inte öppnat för Remote
Desktop av licensskäl.

Vid PuTTY-inloggning anger du
ditt Windows-konto (m5644 som i
exemplet i bild 1) och sedan lösen-
ordet. Svara Ja (Yes) på eventuell
fråga om certifikat.

(Bild 1 - PuTTY är startad , upp-
kopplad mot windows.abc.se och
användarnamnet har angivits)

Efter lyckad inloggning kan du
hantera dina Windows-filer med
bash-skalet. I bild 2 har jag gjort
ett pwd-kommando för att se efter
var jag hamnat, alltså i vilken ka-
talog, efter inloggning.

(Bild 2 - jag är inloggad och har
gjort pwd)

Du kan alltid hitta tillbaka till den
här första katalogen genom att göra
cd $MYHOME   .

Den här katalogen är dock en an-
nan hemkatalog än den vanliga där
t ex filer för dina hemsidor och
annat ligger. Det beror på hur
CopSSH är installerat, och skulle
det bli stor rusning till att köra
CopSSH så kanske vi får överväga
att installera om.

För att komma till den ”vanliga”
hemkatalogen gör du
cd /cygdrive/d/home/m5644
som i bild 3.
Byt förstås ut m5644 mot ditt eget
konto.

Hantera dina
Windows-filer

hos ABC med SSH

Bild 1Bild 1Bild 1Bild 1Bild 1  PuTTY är startad , uppkopplad mot
windows.abc.se och användarnamnet har angivits

Bild 2Bild 2Bild 2Bild 2Bild 2  Jag är inloggad och har gjort pwd
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(Bild 3 - nu har jag flyttat mig till
min ”riktiga” hemkatalog på
servern)

I bild 4 går jag med en ny cd vi-
dare till underkatalogen där min
hemsidas filer ligger
(public_html) och listar mina
*.htm-filer med ls-kommandot:

(Bild 4 - jag tittar på vilka htm-fi-
ler jag har i public_html)

Det går förstås bra att t ex skapa
en länk från den första hemkatalog
som vi hamnade i (se bild 2) till,
exempelvis, hemsideskatalogen:

ln -s /cygdrive/d/home/m5644
minwebb

Länken i exemplet heter alltså
”minwebb”.

(Bild 5 - Jag har tidigare (syns ej i
bilden) gått tillbaka till första ka-
talogen som visades i bild 2 genom
att göra cd $MYHOME och ska-
par nu en länk till min hemsides-
katalog med ln .)

Till sist, logga ut med kommandot
exit  .
Frågor? Skriv i något av ABC-
KOMs möten ABC-klubbens Da-
torsystem eller Windows. Du kan
även skicka ett email till
Windows@abc.se  .

Johan Kullberg <m5644>

 Lokalen i Alvik är
öppen på

tisdagskvällarna.
För mer information

kontakta kansli@abc.se
eller ring:

08-801725
Bild 5. Bild 5. Bild 5. Bild 5. Bild 5. Jag har tidigare (syns ej i bilden) gått
tillbaka till första katalogen som visades i bild 2
genom att göra cd $MYHOME och skapar nu en länk till
min hemsides-katalog med ln .

 Bild 3.Bild 3.Bild 3.Bild 3.Bild 3.  Nu har jag flyttat mig till min ”riktiga”
 hemkatalog på servern

 Bild 4.  Bild 4.  Bild 4.  Bild 4.  Bild 4.  Jag tittar på vilka htm-filer jag har i
 public_html
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Posttidning B
Begränsad
Eftersändning
Vid definitiv eftersändning återsänds försändelsen
med den nya adressen på baksidan (ej adresssidan).

Avsändare
ABC-klubben
Box 14 143
167 14 Bromma

EEEEE

Göran TengnerGöran TengnerGöran TengnerGöran TengnerGöran Tengner
 har gått bort har gått bort har gått bort har gått bort har gått bort

Jag läser i bladet ”DIS-
PLAY”, nr 2-2008 att ABC-med-
lemmen Göran Tengnér gått bort i
februari. Han föddes redan 1918
och var tidigt ute med att ha
beräkningsmodeller för vattentuber
på ABC80.

Han grundade även lokal-
föreningen DIS-ÖST (Föreningen
för datorhjälp i släktforskningen,
regionförening Öst). DIS tar fram
programvaran DisGen som används
av släktforskare för att registrera
släktträden. Göran var en av dri-
vande redan i version 3.3 och har
sedan dess varit en av dem som
drivit fram en del viktiga tillägg till
och med nuvarande version 8, inte
minst den ganska nya kart-
funktionen.

DIS-ÖST är en av de mer
livaktiga delarna av DIS och jag vill
minnas att vår egen östra lokalför-
ening, ABC-ÖST var den lokalför-
ening som levde längst. Jag hörde
till dem som köpte en del material
därifrån när de la ned verksamheten
i början av 2000-talet någon gång. I
Linköping finns ju dessutom
datorförening Lysator som jag vill
minnas är kopplad till universitetet,
och när jag själv studerade vid
Stockholms universitet var Lysators
konfererenssystem LysKOM flitigt
använt även av oss här uppe. Det är
sedan inte så hemskt långt till
Målilla i norra Småland, där man
reparerade ABC-datorer in på 1990-
talet, eller var det ännu längre?

Johan Kullberg  5644

Gimp 2,6Gimp 2,6Gimp 2,6Gimp 2,6Gimp 2,6
Ett bra bildbehand-Ett bra bildbehand-Ett bra bildbehand-Ett bra bildbehand-Ett bra bildbehand-
lingsprogram som är gratis.lingsprogram som är gratis.lingsprogram som är gratis.lingsprogram som är gratis.lingsprogram som är gratis.

Motsvarigheten till Adobe Photoshop
och Paint Shop Pro heter  Gimp och är
gratis. Den har nu blivit lite uppdaterad
till en häftigare version med fler nya
funktioner samt det efterlängtade
gränssnittet.

http://www.gimp.org

MultimediabyrånMultimediabyrånMultimediabyrånMultimediabyrånMultimediabyrån

Här hittar du gratis kurser för bl.a
bildbehandling. Varför inte lära sig lite
om gratisprogrammet Gimp.

http:/www.multimedia.skolutveckling.se
/Kurser/BildBildredigering-i-GIMP/

Starta Linux,Starta Linux,Starta Linux,Starta Linux,Starta Linux,
på 3 snabba!!på 3 snabba!!på 3 snabba!!på 3 snabba!!på 3 snabba!!

Japanese embedded Linux house Lineo
has announced a quick-start technology
that it claims can boot Linux in 2.97
seconds on a low-powered system. The
technology appears similar to but much
faster than Linux’s existing ”suspend-to-
disk” capability.

http://www.linuxdevices.com/news/
NS5185504436.html?kc=rss

FFFFFaktabankenaktabankenaktabankenaktabankenaktabanken

En rolig sida som kanske ger svar på
många av dina frågor.

htp://www.Faktabanken.se


